MultiSpect Analysis
User Manual
For software version 22.2 (August 2018)

1

The information in this manual describes the product at the time of writing and is subject to change without
notice. Kromek frequently releases new software and hardware revisions and this manual may differ from what
is seen.
Functionality within the software is controlled by licence. Which features are accessible will depend on the
licence type applied by the user.
The Kromek logo, KSpect, MultiSpect, MultiSpect Analysis, D3, D3S, SIGMA, TN15, K102, GR1, Quant for GR1,
and RayMon are registered trademarks of Kromek Limited.
© Kromek Limited. All rights reserved.
Windows is a registered trademark of Microsoft Corporation in the US and other countries.

2

Contents
Introduction ........................................................................................... 6
Software Installation .............................................................................. 6
Software Updates .................................................................................. 6
Licensing ................................................................................................ 7
Activating a licence ...................................................................................... 7
Moving a licence .......................................................................................... 7
Upgrading your licence ................................................................................ 7

Main Screen Overview ........................................................................... 8
Shortcuts ............................................................................................... 9
Keyboard shortcuts...................................................................................... 9
Quick Access Toolbar ................................................................................... 9

Connecting Detectors ........................................................................... 10
Detector serial numbers ............................................................................ 10
Selecting detectors in KSpect .................................................................... 11

Acquiring Data ..................................................................................... 12
Starting data acquisition ............................................................................ 12
Clearing acquired data ............................................................................... 12
Acquisition time limits ............................................................................... 12
Performing auto-repeats ........................................................................... 12
Overflow bin suppression .......................................................................... 13

Spectrum Cursor .................................................................................. 13
Detector and Measurement Thumbnails ............................................... 14
Spectrum Display Settings .................................................................... 15
Zooming ..................................................................................................... 15
Vertical scale .............................................................................................. 15
Channels or energy on horizontal axis....................................................... 16
Visible spectra............................................................................................ 16
Spectrum colour ........................................................................................ 17

Energy Calibration ................................................................................ 17
Efficiency Calibration............................................................................ 18
Defining the calibration ............................................................................. 18
Managing efficiency calibrations ............................................................... 21

Other Device Settings ........................................................................... 21
Lower-level discriminator (LLD) adjustment ............................................. 22
Software cut-off ......................................................................................... 22
Dead time factor ........................................................................................ 22
Polarity adjustment ................................................................................... 22
Resolution calibration ................................................................................ 22
Save neutron counts in gamma spectrum ................................................. 23

Spectrum Data Box............................................................................... 23
Spectrum acquisition data ......................................................................... 23

3

Scale ranges ............................................................................................... 23
Cursor position .......................................................................................... 23
Region of interest (ROI) ............................................................................. 24
Active device .............................................................................................. 24

Monitor Traces..................................................................................... 24
Adding a new monitor ............................................................................... 25
Editing the monitor settings ...................................................................... 26
Saving and exporting the monitor data ..................................................... 26
Clearing the monitor data ......................................................................... 27

File Operations..................................................................................... 27
Loading measurement files ...................................................................... 27
Importing measurement files .................................................................... 27
Exporting measurement files..................................................................... 27

Reports ................................................................................................ 27
Printing ................................................................................................ 27
Region of Interest (ROI) Operations ...................................................... 28
Defining a region of interest (ROI) ............................................................. 28
Gaussian fitting .......................................................................................... 29
Region of interest calculations .................................................................. 30

Summing Spectra ................................................................................. 31
Summing multiple spectra ......................................................................... 31
Saving an aggregate spectrum................................................................... 32
Loading an aggregate spectrum ................................................................ 32

Measurement Database ....................................................................... 32
Loading a measurement ............................................................................ 33
Saving a measurement .............................................................................. 33
Importing files to the database ................................................................. 33
Editing measurement information ............................................................ 33
Importing measurements from a Kromek device ...................................... 33
Finding measurements .............................................................................. 35
Exporting Data ........................................................................................... 35
Settings ...................................................................................................... 35
Backup ....................................................................................................... 36
Restore ...................................................................................................... 36
Reset .......................................................................................................... 36

Nuclide Database ................................................................................. 37
Managing Nuclides .................................................................................... 38
Nuclide Categories ..................................................................................... 39

Spectrum Peak Analysis ........................................................................ 39
Enabling peak analysis ............................................................................... 40
Configuring peak analysis .......................................................................... 40
Peak area and FWHM analysis results ....................................................... 43
Activity from peak areas ............................................................................ 45
Graphical display of analysis ...................................................................... 46
User-entered comments ........................................................................... 47
Saving and loading the analysis configuration .......................................... 47

4

Simplified Activity Analysis in MultiSpect .............................................. 48
Starting activity analysis ............................................................................ 49
Configuring activity analysis ...................................................................... 49
Analysis configuration options .................................................................. 50
Results ....................................................................................................... 51
Saving and loading the analysis configuration .......................................... 52
Calibration of simplified activity ................................................................ 53

Scripting .............................................................................................. 54
Example: repeat measurements with a single detector ............................ 55
Example: repeat measurements with multiple detectors ......................... 56
Execution at start up.................................................................................. 57

Index ................................................................................................... 58

5

Introduction
MultiSpect Analysis is designed for Kromek’s range of USB radiation detectors giving
easy connection and setup, and analysis functions tailored to the detectors and their
applications. MultiSpect Analysis Premium adds advanced functions for the
quantitative analysis of activity which are not present in standard MultiSpect
Analysis.
KSpect is a free version of the software with capabilities for data acquisition from one
gamma and one neutron detector at a time, and basic peak region of interest analysis,
without the advanced features of MultiSpect Analysis.
In order to use MultiSpect Analysis a licence is required that is supplied by Kromek
which enables either the standard or the premium features. Without a valid licence,
or after a trial licence has expired, MultiSpect Analysis will run with only the KSpect
features available.

Software Installation
KSpect and MultiSpect Analysis are compatible with Windows 7, Windows 8 and
Windows 10.
To install the software, double-click the ‘setup.exe’ file, ensuring that in the same
folder is the desired version of ‘MultiSpect Installer.msi’, with no other files with the
same name in the same directory.
Microsoft SQL Server is installed alongside KSpect and MultiSpect Analysis. The
installer will prompt the user if additional downloads are required from Microsoft
during the installation process.

Software Updates
The software will check for updates periodically. If an update is found on the server
the user is notified and given the option to download and install the update. The user
can make the software check whether an update is available by selecting ‘Check for
Updates’ from the ‘Help’ menu. If there is no internet connection on the computer
running KSpect or MultiSpect Analysis installer files can be downloaded from the
Kromek website. If the current licence will not work with the updated software the
user cannot download the update. Notifications for updates which require a licence
upgrade can be turned off by clicking ‘File’, followed by ‘Preferences’, and then
clicking the checkbox for hide incompatible updates.
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Licensing
When MultiSpect is run for the first time it will ask the user to enter a licence. The
licence controls which features are available to the user. A new licence can be applied
at a later time by selecting ‘Enter New Licence’ from the ‘Help’ menu.

Activating a licence
A licence can be activated in one of three ways:
1.
2.

3.

Over the internet using a licence key
Via another computer that has an internet connection using a licence key (if
you have no internet connection on the computer where the software is
installed)
Using a file if you have been supplied with a licence file instead of a key

Please select the appropriate option and follow the on-screen instructions.

Moving a licence
To move your software licence to another machine please contact Kromek to have
your licence reset. Moving your licence is free provided the licence is still valid.

Upgrading your licence
To upgrade your licence please contact Kromek for a new licence key. The new licence
can then be applied by selecting ‘Enter New Licence’ from the ‘Help’ menu.
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Main Screen Overview
When first loading KSpect or MultiSpect Analysis the main window is displayed:

A
B
C

D
E
A. Quick Access buttons on the top title bar always give convenient access to the most
important functions regardless of which menu tab is displayed. These can be
configured from the drop-down menu to the right.
B. The menu ribbon. This contains controls for starting an acquisition, viewing the
data and choosing the analysis that is performed on the measured data. Doubleclicking the tabs at the top of the ribbon allows it to be hidden, giving more space for
the display of data.
C. The plot area. This shows the data acquired from the detectors. When the ‘Spectra’
tab below the menu ribbon is selected, the energy spectra from the detectors are
displayed, and when the ‘Monitors’ tab is selected the count rate against time is
plotted for the detectors. Note that only spectra are visible in KSpect.
D. The spectrum data box. When on the ‘Spectra’ tab a spectrum data box gives
information on the active measurement and detector.
E. Detector and measurement thumbnails. Every detector connected to MultiSpect,
and every loaded measurement, is given a thumbnail. The thumbnail gives controls
over just that single set of data. Clicking the thumbnail makes it active, shown by a
green border, and all analysis is performed on the active measurement.
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Shortcuts
Keyboard shortcuts
The following keyboard shortcuts are available in MultiSpect:
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

F1 – Start/Stop acquisition
F2 – Clear spectrum
F3 – Save spectrum
F4 – Zoom in spectrum horizontally
F5 – Zoom out spectrum horizontally
F6 – Zoom out horizontally to show entire spectrum
F7 – Gaussian fit on selected ROI
F8 – Set Region Of Interest start/stop
F9 – Clear selected Region Of Interest
F10 – Enumerate Quick Access toolbar icons for keyboard access
F11 – Toggle Energy Mode
F12 – Open the help manual
Up arrow – zoom in spectrum vertically
Down arrow – zoom out spectrum vertically
Right arrow – move the spectrum cursor one channel to the right
Left arrow – move the spectrum cursor one channel to the left
Page Up – move the spectrum cursor multiple channels to the right
Page Down – move the spectrum cursor multiple channels to the left
Holding shift while clicking on the spectrum sets the ROI start/stop to the
location clicked

Quick Access Toolbar
The Quick Access toolbar (see Main Screen Overview) contains shortcut icons to some
frequently used functions. Pressing the arrow at the end of the list of icons opens the
Quick Access toolbar customisation menu, which allows different functions to be
added to/removed from the Quick Access toolbar.
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Connecting Detectors
Connect a compatible detector to the computer using a USB cable. The software will
recognize the hardware and indicate that the device is connected in the status bar at
the bottom of the window.
The software displays a dialogue listing the newly-connected detector, asking you to
enter or confirm the serial number of the detector:

Enter the serial number of the detector and click ‘OK’.
The device is now ready to start acquiring data.

Detector serial numbers
KSpect and MultiSpect Analysis allow you to enter calibration data and other device
settings for each detector and save this information for future use when the same
detector is connected again. It is important to use the same serial number for the
detector each time you connect that detector so the correct stored values are used.
You must give each detector a unique serial number. The serial number can be any
text, but we suggest you use the serial number printed on the detector if possible.
For some devices models, the serial number will be read from the device by
MultiSpect, and suggested as the default. If you have more than one detector
connected, you can see which is which by checking the Port names in the dialogue.
The Port names identify the USB ports you have connected the detectors to, and will
be the same when you connect the detectors again.
When you re-connect a detector on the same USB port, if it hasn’t a serial number
that can be read electronically from the detector, KSpect/MultiSpect assumes that
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this is probably the same detector you last connected to that port, and puts the serial
number of that detector in the serial numbers dialogue. So if you always use the same
detectors in the same USB ports, all you have to do after the first time is check that
the serial numbers in the dialogue are correct, and click ‘OK’ or press the [Enter] key.
The software remembers each serial number you have used. So if you change which
detector is connected to which port, you can simply select the correct serial number
from the drop-list of serial numbers beside each detector.
If you choose the wrong serial number, and you only realize this after you have closed
the dialogue, just disconnect the detector and re-connect it - The software will display
the dialogue again so you can select the correct serial number.
Known detectors can be managed by selecting ‘Manage Detectors’ from the ‘Setup’
menu allowing editing of device information and records of old detectors that are no
longer used to be removed.

•

Create can be used to add a new detector.

•

Edit will allow the serial number or the device type to be changed.

•

Delete removes the detector and all associated calibrations.

Selecting detectors in KSpect
KSpect is limited to only acquiring from one gamma ray detector and one neutron
detector at any one time, plus a dose detector on some devices. If multiple detectors
are connected the active detector can be selected from the ‘Setup’ menu.
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Acquiring Data
MultiSpect Analysis can acquire from all connected detectors simultaneously. KSpect
supports acquisition from one single gamma ray detector and one neutron detector
at a time. The active detector can be selected from the Setup menu.

Starting data acquisition
Pressing the ‘Acquire’ button located either on the ‘Acquisition’ menu or shortcut
menu at the top, or pressing [F1], will begin collecting data from all the enabled
detectors.
When detectors are first connected they are enabled for data collection by default. If
multiple detectors are connected it is possible to disable an individual detector to
stop data being recorded during acquisition using the button on the detector
thumbnail (see page 14).

Clearing acquired data
MultiSpect Analysis can simultaneously display results from multiple detectors and
loaded measurements. At any one time there is one selected or "active"
measurement, which is chosen by clicking on a thumbnail, and is highlighted by a
coloured border around the thumbnail. After selecting the thumbnail showing the
data to be cleared press the ‘Erase’ button, or the [F2] key, to clear the data.

Acquisition time limits
The acquisition of data can be stopped automatically after a user specified time limit
has elapsed. Two different time limits are available: real time and live time. Real time
is the total duration of the measurement. Live time is the total time the detector has
been active and able to record data. The values of these limits are set using the ‘Real
time’ and ‘Live time’ limits controls located on the ‘Acquisition’ menu.
A limit of zero will be ignored and allow acquisition to continue indefinitely. If both
limits are set to non-zero values, the one that is reached first will stop the acquisition.
If both limits are zero, the acquisition will not stop until the ‘Stop’ button, or the [F1]
key, is pressed. The limits can only be adjusted when the acquisition is not active.

Performing auto-repeats
Repeated acquisitions of a fixed duration can be saved into the database
automatically. They are configured from the ‘Acquisitions’ menu. All enabled
detectors will be included in the repeat measurements.
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To perform repeated acquisitions:
1.
2.

3.
4.
5.
6.
7.

Set the number of measurements to perform in the ‘Acquisitions’ field. Set
this value to ‘1’ to disable repeated acquisitions.
Provide a ‘Save Name’ that will be used for the measurements in the
database. This ‘Save Name’ will have the number of the repeat appended
when saved. The ‘Same Name’ will be used for measurements from all
detectors in the acquisition.
To clear the data before each repeat tick the ‘Clear on each acquisition’
checkbox.
Provide a ‘Live Time’ and/or ‘Real Time’ limit for each repeat.
Enable/disable the detectors you wish to include/exclude from the
acquisitions using the controls on the detectors’ thumbnails.
Start the acquisitions by clicking the ‘Acquire’ button.
Repeat acquisitions can be cancelled at any time by clicking the ‘Stop’
button. All completed acquisitions up to that point will have been saved into
the measurement database.

Overflow bin suppression
The highest channel of a spectroscopic detector is used to collect all counts that are
higher than the upper range of the detector. This can result in a spike appearing at
high energies depending on the type of detector being used. To avoid this spike the
overflow counts can be suppressed. This suppression can be enabled or disabled
using the ‘Suppress overflow channel’ checkbox under ‘File’ → ‘Preferences’.
Suppression is enabled by default when the software is first installed. When
suppression is enabled, the top channel value is set to zero when the measurement
is displayed and saved, and the data from that channel is irrevocably lost.

Spectrum Cursor
A vertical dashed line in the plotting area of the ‘Spectra’ tab forms a cursor allowing
data to be read from the graph and several different operations such as region of
interest (ROI) selection, energy calibration, and lower-level discriminator (LLD)
adjustment.
The position of the cursor can be shifted by a single channel using the [Left] or [Right]
arrow keys on the keyboard. Larger steps in the cursor position are obtained by
pressing the [Page Down] or [Page Up] keys. Left-clicking the mouse anywhere on the
spectrum plot will also move the cursor to that channel in the spectrum.
The ‘Cursor data’ section of the spectrum data box gives the spectrum information at
the position of the cursor.
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Detector and Measurement Thumbnails
Below the data plots section are the thumbnails. Each thumbnail shows a miniature
representation of the data from the detector. The source of the data is shown
underneath and there is a toolbar of buttons to manage the data at the top. Hovering
the mouse over the thumbnail will display the serial number or measurement name
of the thumbnail.
Toolbar buttons
Enable/disable acquisition; when acquisition is started, only those
detectors that are enabled will acquire data. During acquisition, the
enable and disable acquisition buttons are disabled
Save the data (if it has changed since the last save)
Hide/show the data in the main plot
Clear or close the measurement
Configure the spectra used as inputs to an aggregated spectrum
Visible

Hidden

Enabled Disabled

A column of similar buttons on the left of the thumbnails allows control over all
measurements and detectors simultaneously.
Additional functions are available by right-clicking the thumbnail. For example, data
can be copied to a new thumbnail by right-clicking the existing thumbnail and
selecting ‘Copy’. This is particularly useful for preserving acquired data and using it
for comparison.
After loading a measurement, the information on the measurement can be seen by
right-clicking the thumbnail and selecting ‘Measurement Information‘. A window is
displayed showing information including any associated neutron measurements. This
window also allows some of the data to be edited.
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Spectrum Display Settings
Spectrum display settings can be found on the ‘Spectra’ menu. The menu will only be
visible when the ‘Spectra’ view is shown.

Zooming
Pressing ‘Zoom in’ at the top, or pressing the [F4] key, zooms in horizontally at the
position of the cursor. The plot area is split into two sections, the top showing the full
range spectrum and the lower the zoomed in region. Pressing ‘Zoom in’ again
increases the level of magnification. Zooming can also be achieved with the mouse
wheel after clicking on the spectrum.
Clicking at a different point on the top spectrum changes the region shown in the
zoomed in section of the display. Directly beneath the plot area is a scroll bar that can
also be used to change the view area when the horizontal scale has been zoomed in.
Additionally, right-clicking the mouse when the pointer is over the spectrum display
will bring up a context menu with selections for zooming.
The spectrum can be returned to full scale by repeatedly pressing ‘Zoom Out’ / [F5]
or pressing ‘Full Scale’ / [F6].

Vertical scale
The vertical axis of the spectrum plot is in units of counts. The maximum displayed
value can be changed using the ‘Vertical Scale’ drop-down list located on the ‘Spectra’
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menu. Pressing the [Up]/[Down] arrow key will also move the axis maximum counts
stepping up/down through the available values.
This maximum-counts value can be set to a fixed value, or to automatically adjust to
the maximum value of the data being plotted. You can choose whether auto-scaling
adjusts to accommodate all spectra or just the active spectrum in the program
‘Preferences’ from the ‘File’ menu.

Channels or energy on horizontal axis
Note: This functionality is not present in KSpect
Spectral data from a detector can be plotted by the raw channel in which the counts
were detected. If an energy calibration exists for the detector, providing the
conversion from channel to energy, the spectrum can also be plotted on an energy
scale. To enter an energy calibration see the Energy Calibration section (page 17). The
‘Energy Mode’ buttons located on the ‘Spectra’ and ‘Analysis’ menus allow the user
to switch between displaying the spectrum with the channel and the energy on the
x-axis.

When multiple detectors are connected their spectra may not be directly comparable
because of differences in the energy calibrations. MultiSpect Analysis transforms the
channel counts into energy bins using an interpolation algorithm to reassign event
counts from the detector channels to the normalised energy channels, maintaining
the total counts from the detector. The user can select the energy interval using the
‘interval’ drop down box. In this energy display mode, the spectra from different
detectors are directly comparable, and operations can be performed to combine
measurements from different detectors.

Visible spectra
Any number of spectra can be loaded into memory and displayed with MultiSpect
Analysis. KSpect is limited to 5 spectra at a time. Each spectrum can be made visible
or hidden by clicking on the Show/Hide button in the toolbar of the spectrum’s
thumbnail. The currently active spectrum is always visible.
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Spectrum colour
The colour used to display the spectrum can be changed by right-clicking the
thumbnail and selecting ‘Colour…’.

Energy Calibration
Each spectral detector has its own energy calibration for converting the channel
number into the energy corresponding to that channel. Using a suitable radiation
source, the energy of particular channels can be measured. When two or more data
points for the calibration are entered the energy calibration will automatically be
calculated. The energy calibration is determined through a fit of the channel-keV
conversion data points to a polynomial line. The order of the polynomial used can be
changed using the ‘Order of fit’ drop-down box.
To enter a calibration right-click the detector thumbnail and select ‘Energy
Calibration’. This can also be done by selecting the thumbnail and clicking ‘Energy
Calibration’ located on the ‘Acquisition’ menu. A data grid will be displayed allowing
pairs of channel and energy values to be entered:

Using this window, data points can be directly entered into the data grid. The ‘Add
Cursor Point’ button will set the channel cell in the current spreadsheet row (the row
where the spreadsheet cursor is positioned) to the channel value of the spectrum
cursor.
A shortcut for adding an energy-channel point to the calibration is to type the energy
directly into the spectrum data box below the plot. With the plot cursor positioned in
the desired channel, the energy of that channel can be typed into the energy text box
either in the ‘Cursor data’ section, or under ‘Centroid’ in the ‘ROI data’ section.
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Similarly, the centroid channel found by a Gaussian fit to a peak can be added as a
calibration point by typing the energy of the peak in the energy centroid field in the
Gaussian fit window (see page 29).
The ‘Delete Point’ button will delete the data contained in the current spreadsheet
row. Deleting a data point can also be accomplished by selecting and deleting the
energy value associated with the point in the spreadsheet. Finally, pressing the ‘Reset’
button deletes all the data points, clearing the calibration.
The calibration for the active spectrum can be copied from that of another spectrum
loaded in memory by selecting ‘Copy Calibration From’ and then selecting the source
spectrum from the drop-down list.
When modification of the calibration is finished, the calibration window can be closed
using the standard window close button located at the upper right corner of the
window.

Efficiency Calibration
Note: This functionality is only present in MultiSpect Analysis Premium
Where the detector and radioactive sources are used in a fixed geometry an efficiency
calibration of the system can be used, together with the measured count rates in
spectrum peaks, to calculate the source activity. Tools are provided allowing the user
to determine the efficiency of their system using a calibration source of known
activity. The detector must have an energy calibration and a resolution calibration
before an efficiency calibration can be entered, and the spectrum must be displayed
in ‘Energy Mode’ with an energy horizontal axis (see page 16).

Defining the calibration
The efficiency calibration is defined in the ‘Detector Settings’ window which can be
opened from the ‘Setup’ ribbon menu, or by right-clicking the measurement/detector
thumbnail. The ‘Efficiency Calibration’ tab shows the calibration, the fit to the data
and the 1 standard deviation confidence limits on the fit to the data. The graph can
be viewed on either a linear or log scale by changing the option in the dropdown box
above the graph.
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Each efficiency point, ε, in the efficiency calibration is defined from:
𝜀=

𝑅
𝑆𝑃𝛾

Where:
R is the measured photopeak net count rate,
S is the activity of the source on the measurement date, and
Pγ is the probability of emission of the gamma rays being measured.
All efficiency calibration points must be made with the same region of interest width
factor setting for analysing the net counts in the peak.
The error on each data point is calculated from the errors on the net count rate and
the source activity.
After recording a spectrum from a calibration source of known activity place the
cursor on a photopeak and press the ‘Add Cursor Point’ button. An efficiency
calculation window is displayed allowing the efficiency and error to be determined
for the selected peak.
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Choose the radionuclide and emission line for the selected peak. MultiSpect will
measure the net counts in the peak. The number of bins used on each side of the
peak for determining the background to be subtracted can be adjusted with the
‘upper’ and ‘lower’ window controls under the display of the peak.
Enter the calibrated activity of the source and the one standard deviation uncertainty
in the activity for the reference date when the source was calibrated. MultiSpect uses
the half-life of the radionuclide for calculating the activity on the spectrum
measurement date.
The calculated efficiency and error are displayed at the bottom of the screen. To add
this as a data point to the efficiency curve press ‘Add’.
Fit to the efficiency data
MultiSpect fits the efficiency data points with the following curve:
ln(𝜀) = 𝑎0 + 𝑎1 ln(𝐸) + 𝑎2 ln(E)2 + ⋯ + 𝑎𝑛 ln(E)n
Where:
ε is the efficiency,
E the energy,
ai are fitted coefficients,
and the order of fit, n, is between 3 and 7.
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The user must select the order of fit most suitable for their data from the control on
the ‘Efficiency Calibration’ tab. The ±1σ errors on the fitted line are shown with pale
pink lines on the calibration curve. It is important to inspect these errors to identify
if the chosen curve is a realistic fit to the data.
Note that the validity of the fit outside the region where data points lie falls rapidly
and causes large errors on the extrapolated values. A wide range of data points
should be included in the calibration.

Managing efficiency calibrations
Saving and loading efficiency calibrations
After an efficiency calibration has been entered, it can be saved for future use in the
‘Favourites’ menu. This allows several efficiency curves to be stored for different
geometries. The same menu allows a stored calibration to be loaded to the detector.
Only one efficiency calibration can be loaded at a time, and this is the one used for
analysis.
When a measurement is saved in the database the efficiency calibration is saved with
that measurement for future use.
Copy calibration from another measurement or detector
The efficiency curve can be copied from another live detector or loaded measurement
to another by using the ‘Copy Calibration From…’ option on the ‘Efficiency Calibration’
tab of the ‘Detector Settings’ window.
Exporting/Importing efficiency calibrations
Efficiency calibrations can be exported and imported from the star menu to move
them to other computers which use the same detector or where analysis will be
continued.

Other Device Settings
Depending on the particular type of detector that is connected additional settings
may be available. These are all displayed in the ‘Device Settings’ window (accessed
from the ‘Setup' menu or from right-clicking the thumbnail). These operations are
described below. They relate to the active thumbnail and clicking between
thumbnails will show the settings for the chosen detector or measurement.
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Lower-level discriminator (LLD) adjustment
The LLD is a setting of the attached detector. This setting is a channel value
corresponding to a pulse height (corresponding to a channel) below which the
spectrometer should ignore all pulses. To adjust the LLD, click ‘Set LLD’ from the
‘General’ tab of ‘Device Settings’. The spectrum cursor will change to one labelled ‘Set
LLD’, and will appear at the location of the current LLD setting. The LLD setting is then
adjusted by moving the cursor. The cursor can be moved with the [Left]/[Right] arrow
keys, with the [Page Up]/[Page Down] keys, by left-clicking with the mouse anywhere
along the spectrum, or by left-clicking on the plot cursor and dragging with the
mouse. The LLD is typically set to cut out the noise counts at the low-energy end of
the spectrum. After the desired LLD is set, click ‘Set LLD’ or press [Enter] to exit ‘Set
LLD’ mode.

Software cut-off
In addition to the hardware LLD, a software cut-off can be applied. This simply ignores
(sets to zero) all counts below a given channel. It is specified in channels relative to
the hardware LLD position. To set this cut-off, go to the ‘General’ tab of ‘Device
Settings’, enable it using the ‘Enabled’ checkbox, and then enter the number of
channels to offset it from the hardware LLD.

Dead time factor
KSpect and MultiSpect Analysis calculate dead time in the detectors based on a single
dead time factor which is set on the ‘General’ tab of the ‘Device Settings’ window.
Total dead time, D, is calculated from: 𝐷 = 𝜏𝑀𝑇, where τ is the dead time constant,
M is the measured count rate, and T is the real time. The live time, L, is then
calculated from: 𝐿 = 𝑇(1 − 𝜏𝑀).

Polarity adjustment
When connected to a Multi-Channel Analyser (MCA) the polarity of the incoming
pulses to the MCA must be set. This is done from the ‘General’ tab by selecting either
positive or negative from the polarity section.

Resolution calibration
The variation of the resolution of the detector with respect to channel is shown in the
Resolution Calibration tab. This is used in the peak analysis functions within
MultiSpect Analysis. A default resolution curve is provided for each model of
detector, but this curve can be edited per-device.
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Save neutron counts in gamma spectrum
If a neutron detector is connected that only measures neutron counts, not a
spectrum, there is an option within the neutron detector’s ‘Device Settings’ to save
the neutron data within gamma-ray measurements of all gamma-ray detectors
connected at the same time. This enables the neutron field to be measured and
recorded alongside the gamma-ray data for future analysis. This is available in both
KSpect and MultiSpect Analysis.

Spectrum Data Box
On the ‘Spectra’ tab, below the spectrum plot, is a pane containing data associated
with the spectrum acquisition, spectrum plot scales, cursor, and current region of
interest.

Spectrum acquisition data
‘Real time’ is the total time that has elapsed during the acquisition of data. ‘Live time’
is the length of time that the pulse processing hardware has been active and able to
detect pulses during the data acquisition. In other words, live time is the real time
reduced by the total time that the hardware has been inactive as a result of pulse
processing activities. ‘Dead time’ is the instantaneous percentage of time that the
hardware is unable to detect pulses (is ‘dead’) due to pulse processing activities.
‘Count rate’ is the number of events detected per second of real time, and is shown
both as a number and via a horizontal graphical bar.

Scale ranges
The next data group from the left, ‘Scale ranges’, lists the maximum number of counts
used for the vertical axis of the spectrum plot and the number of channels that the
horizontal axis currently spans. If the active spectrum has been calibrated in energy,
the horizontal axis range is also given in keV.

Cursor position
The next data group from the left, ‘Cursor data’, lists the current cursor location on
the active spectrum in counts, channels, and keV (if calibrated).
The text box displaying the horizontal location in keV may also be used as a data entry
box to assign an energy value to the current cursor location in the energy calibration.
The data entry mode is entered by clicking the keV text box. The desired energy can
then be entered, and, after [Enter] has been pressed, the energy calibration will be
updated by adding the new channel-keV data point to the existing energy calibration.
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Region of interest (ROI)
When the spectrum cursor is positioned in a defined ROI the measurements of the
ROI will be displayed in the ROI data group below the spectrum. See the region of
interest operation section (see page 28). The information includes the summed
counts, centroid, and full-width-at-half-maximum (FWHM) of the peak. Whether a
background is subtracted or not from the ROI is controlled from the Spectra tab of
the ribbon menu at the top of the screen.
The text box listing the Centroid in keV may also be used as a data entry box to assign
an energy value to the current centroid channel location in the energy calibration, in
a similar way to using the ‘Cursor data’ text box. Left-click the keV text box and the
desired energy can then be entered, and, after [Enter] has been pressed, the energy
calibration will be updated by adding the new channel-keV data point to the existing
energy calibration.

Active device
For the active device or measurement thumbnail the active device box shows the type
of the detector used to record the data, the serial number of that device, the Lower
Level Discriminator (LLD) setting, and the setting of the Software Cut-Off (SCO).

Monitor Traces
Note: This functionality is not present in KSpect
When the ‘Monitors‘ tab is clicked above the plot area the count rate monitor traces
are displayed for all the connected detectors. Each trace allows changes in the count
rate recorded from the detector to be seen over time. Monitor traces are only
updated during acquisition and are not dead time corrected. Press the ‘Acquire’
button located on the ‘Acquisition’ menu to begin acquisition. Moving the mouse
pointer over the monitor trace displays a cursor and an information box showing the
count rate and the time at that point on the trace.
Note: MultiSpect Analysis reads data from the detectors via USB. Depending on the
computer being used to run MultiSpect Analysis buffering of USB data can cause
delays in receiving data from the detector and add noise on monitor traces with short
aggregation times. This will become more pronounced if the computer is running
many processor heavy tasks or has insufficient free resources.
By default, each detector has one monitor showing the total count rate from all
energy channels, although different energy ranges can be configured manually. This
is useful for monitoring the count rate in one particular gamma ray peak for example.
Monitors for neutron detectors only show the total counts detected. Monitor traces
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are automatically saved against each detector serial number so the next time the
detector is connected the previously configured monitor traces are displayed again.

The time period being viewed can be chosen by using the ‘Display Interval’ drop-down
menu located on the ‘Monitors’ menu. For each time period 121 data points are
shown. The time periods available are:

Time Period Shown
2 minutes
30 minutes
1 hour
4 hours
12 hours
1 day

Data aggregated over
1 second
15 seconds
30 seconds
2 minutes
6 minutes
12 minutes

Individual monitor traces can be removed by using the red cross on each trace. All
monitors from a detector can be hidden by clicking on the ‘hide’ icon on the detector
thumbnail which also hides the spectra on the ‘Spectra’ tab.

Adding a new monitor
New monitor traces can be added by first selecting the detector thumbnail and then
clicking the ‘Add Monitor’ button located on the ‘Monitors’ menu. This will bring up
the ‘Rate Monitor Settings’ window:
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A name should be given to the monitor for identification. The filters can be used so
that only the aggregated counts from a particular region of the spectrum are plotted
in the monitor trace.

Editing the monitor settings
The settings for a particular monitor trace can be viewed and edited by clicking the
‘Settings’ button on the monitor trace, or by right-clicking on the trace and choosing
‘Settings’ from the menu. The ‘Rate Monitor Settings’ dialogue is displayed from
which the name can be changed, and the energy range or channel range used in the
monitor can be edited. Changes made to the monitor take effect from then on; old
data are not recalculated to show it on the same basis.

Saving and exporting the monitor data
Monitor data cannot be saved in the measurement database. It can be exported to a
.csv file to preserve a record of the data. Press the ‘Export’ button on the monitor
trace to save the data for the time period being viewed.
The exported data file has a header section showing the settings for the monitor. The
data is in rows with a row for each time period. Each row has a time stamp, the total
counts recorded in that period, and the total real time in seconds for which the
detector was acquiring data during that time period. The count rate can be calculated
by dividing the total counts by the real time.
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Clearing the monitor data
All the data for a particular monitor can be cleared by pressing the ‘Clear’ button on
the monitor trace, or from the right-click menu. This will permanently erase the data.

File Operations
Loading measurement files
Opening a spectrum directly from a file can be done from the ‘File’ menu by choosing
‘Open a file’, or by dragging and dropping a spectrum file into the main window. If
MultiSpect is selected as the default program for a filetype extension, simply doubleclicking the file in Explorer will open it in MultiSpect.

Importing measurement files
Measurement files can be imported to the database. See Importing files to the
database (page 33).

Exporting measurement files
Complete measurements comprising the spectrum, energy calibration and all analysis
are saved in a database of measurements, from where they can be exported if
required. For details of working with the database please see the Measurement
Database section of this help file (page 32).

Reports
The spectrum and analysis results can be presented together in a convenient report.
This is exported in .pdf format for ease of sharing. The ‘Generate Report’ button is
located on the ‘Reports’ menu. The report options will be displayed for choosing
which information should be shown on the report.
The units of measurement used in the report can be configured between SI and US
standard units from the ‘Preferences’ screen which is accessible from the ‘File’ menu.

Printing
A snapshot of the KSpect or MultiSpect Analysis window can be printed by selecting
‘Print’ from the ‘File’ menu. This then brings up a standard Windows print dialogue
from which a specific printer, along with its associated properties, can be selected.
After this selection has been made, the snapshot of the window can be sent to the
printer by clicking on the ‘OK’ or ‘Print’ button of this print dialogue window. Prior to
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printing, the print settings can be adjusted by selecting ‘Print Settings’. The snapshot
can also be previewed by selecting ‘Print Preview’.

Region of Interest (ROI) Operations
When a Region of Interest (ROI) is defined around a peak in a spectrum, and the
cursor is placed within this ROI, the ROI data in the spectrum data box displayed
beneath the spectrum provides the counts, centroid, and FWHM values associated
with the peak.
The integral counts value is simply the sum of all the counts within the ROI, whereas
the net counts number is this same sum reduced by the background counts. The
background is assumed to be a line determined based on the data points at the start
and end of the ROI. If the background subtraction has been turned off from the
‘Spectra’ tab of the ribbon menu the integral and net counts will be the same. The
centroid and FWHM values are given in number of channels and, if a valid energy
calibration exists, in keV. The centroid and FWHM calculation is performed on the net
counts if background subtraction is turned on, or the integral counts if it is turned off.
Each spectrum has its own set of defined ROIs and only those of the active spectrum
will be displayed. An ROI is indicated on a spectrum using colour shading. ROIs are
only displayed when the ROIs are turned on. This state is toggled between on and off
by the ‘Show ROI’ button in the ‘Region of Interest’ section of the ‘Spectra’ tab on the
ribbon menu. This state can also be toggled by right-clicking the mouse when the
pointer is over the spectrum display and then selecting ‘ROI on/off’ from the menu.
The display of ROIs is also turned on if an ROI definition is started.

Defining a region of interest (ROI)
ROIs can be defined using several different methods, but each of the methods makes
use of the spectrum cursor to specify the start and stop channel of the ROI. The
function key buttons ‘ROI start’, ‘ROI stop’, and ‘ROI clear’ can be used to define or
remove an ROI. With the cursor positioned at the start channel of the desired ROI,
clicking on ‘ROI start’ or pressing the [F8] function key starts the ROI definition. The
text of the button then changes to ‘ROI stop’. The ROI definition is then completed by
moving the cursor to the end channel of the ROI and then clicking ‘ROI stop’ or
pressing the [F8] function key again. An ROI can be removed by positioning the cursor
within the ROI and then clicking on ‘ROI clear’ or pressing [F9]. Similarly, ROI definition
and clearing operations can be accessed through the menu that is activated by rightclicking the mouse when the pointer is over the spectrum display. A quick method to
define ROIs is to hold down the shift key while left-clicking with the mouse on the
start channel of the ROI. The ROI definition is completed by again holding down the
shift key while left-clicking on the stop channel of the ROI.
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Gaussian fitting
Once an ROI has been defined, a Gaussian fit can be applied to the spectrum in the
region by pressing ‘Fit Gaussian’ in the ‘Region of Interest’ section of the ‘Spectra’
tab.

This opens a window which displays the spectrum in the vicinity, with a Gaussian fit
applied to the selected region. Key parameters of the fit are displayed underneath.
The region can be finely tuned by dragging the black arrows along the horizontal axis,
or by changing the figures in the ‘ROI Start’ and ‘ROI End’ boxes on the lower left of
the window.

The fit is performed in the horizontal space plotted in the spectrum plot area – when
in Energy Mode, the fit is performed on the transformed data in energy-space.
Once a satisfactory fit has been found, the centroid of the fit can be added directly to
the energy calibration of the spectrum simply by typing the corresponding peak
energy into the box beside the channel centroid, adjacent to the unit label ‘keV’. If
the spectrum already has a valid energy calibration, this box will display the energy
of the fit centroid.
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Region of interest calculations
The Integral Counts value is simply the sum of all the counts within the ROI and is
calculated as follows:
𝑅𝑂𝐼𝑠𝑡𝑜𝑝

IntegralCounts = 

∑

𝐶𝑛

𝑛=𝑅𝑂𝐼𝑠𝑡𝑎𝑟𝑡

Where Cn is the number of counts in channel number n, and ROIstart and ROIstop are
the channel number limits of the ROI.
The Net Counts number is the Integral Counts less the Background Counts. The
background Bn is assumed to be a straight line determined from the data points at
the start and end of the ROI.
The Net Counts values are calculated as follows:
𝑅𝑂𝐼𝑠𝑡𝑜𝑝

NetCounts = 

(𝐶𝑛 − 𝐵𝑛 )

∑
𝑛=𝑅𝑂𝐼𝑠𝑡𝑎𝑟𝑡

The Centroid in units of channel number is calculated from the backgroundsubtracted count data using the equation:
𝑅𝑂𝐼

Centroid = 

𝑠𝑡𝑜𝑝
∑𝑛=𝑅𝑂𝐼

𝑠𝑡𝑎𝑟𝑡

𝑛(𝐶𝑛 − 𝐵𝑛 )

𝑅𝑂𝐼𝑠𝑡𝑜𝑝
∑𝑛=𝑅𝑂𝐼
(𝐶𝑛
𝑠𝑡𝑎𝑟𝑡

− 𝐵𝑛 )

The FWHM in units of channel number is determined using the following procedure:
(1) The background is subtracted from the count data.
(2) The channel containing the maximum counts, Cmax, is determined through a
simple search.
(3) Starting from this maximum-counts channel, the lower channel numbers are
searched for a pair of adjacent channels whose counts straddle a counts value of
Cmax/2.
(4) The lower half-maximum channel value is then calculated from these two
straddle points through linear interpolation.
(5) In a similar manner, the upper half-maximum channel value is determined
through a search of the higher channel numbers starting at the maximum-counts
channel followed by a linear interpolation calculation using the data points that
straddle a counts value of Cmax/2.
(6) Finally, the FWHM is calculated by subtracting the lower half-maximum channel
value from the upper half-maximum one.
If an energy calibration has been completed for the active spectrum, the Centroid and
FWHM values in channels are converted to energy in keV using the energy calibration.
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Summing Spectra
Note: This functionality is not present in KSpect

Summing multiple spectra
MultiSpect Analysis provides a sum function that can sum the channel events counts
from multiple spectra. The results of the sum are displayed in an additional spectrum,
known as an aggregate spectrum.
This is only available in energy display mode (see page 16) where only spectra with
valid energy calibrations are displayed and available for aggregation. Aggregate
spectra are not displayed in channels display mode.
You can create a new aggregate spectrum by clicking on the ‘Create’ button located
on the ‘Analysis’ menu:

MultiSpect creates a new aggregate spectrum thumbnail, distinguished by a ‘sum’
symbol (sigma character) on the left thumbnail toolbar:

To select the spectra to be summed, click on the ‘sum’ button
in the thumbnail
toolbar. This displays a window showing all the spectra that can be summed. Valid
spectra include detector and file spectra with valid energy calibrations. Tick the
checkboxes next to the spectra you want to sum:
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If you reset the calibration of a spectrum that is being used as the input to a sum, that
spectrum is automatically removed from the sum because only calibrated spectra can
be summed.

Saving an aggregate spectrum
An aggregate spectrum can be saved just like any other spectrum. When an aggregate
spectrum is saved, a copy of each input spectrum is also saved.

Loading an aggregate spectrum
When an aggregate spectrum is loaded from a file, a spectrum is also created for each
of the spectra that were inputs to the aggregation when the aggregate spectrum was
saved. Clicking on the ‘Sum’ button on the thumbnail’s toolbar opens a tool window
that allows you to select which spectra act as inputs to the sum in the aggregate
spectrum.

Measurement Database
To allow a spectrum to be saved with the analysis and other associated data such as
locations, KSpect and MultiSpect Analysis use a database for storing complete
measurements. This provides a single location for organizing measurements and all
measurements can be backed up collectively. All users logging on to a particular PC
share the same database with all measurements accessible to everyone.
The database can be opened from the ‘File’ menu by selecting ‘Measurement
Database’, or from the shortcut at the top, if present (see page 8).
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Loading a measurement
To load a measurement from the database, select the measurement in the database
window and press the ‘Load’ button.

Saving a measurement
After selecting a spectrum thumbnail, the measurement can be saved to the database
either from the ‘File’ menu by selecting ‘Save Measurement’, by pressing the save
icon on the thumbnail, or by right-clicking the thumbnail and selecting ‘Save
measurement’. On first saving the measurement the user will be asked to provide
details including a name and notes which are useful for finding the measurement in
the database. These can be edited later if required.

Importing files to the database
Pressing the import button allows existing spectrum files to be imported to the
database. Many files can be imported at the same time by selecting multiple files in
the file browser dialogue box. Supported filetypes are .spe, .n42, .neutron, and .txt.
Imported .txt files must take the form of a single column of integers, each giving the
counts in each channel from 0 to a maximum of 4096 channels.

Editing measurement information
Measurement information can be edited by first selecting the measurement and then
selecting ‘Edit information’ from the toolbar buttons at the top.

Importing measurements from a Kromek device
Note: This functionality is not present in KSpect
MultiSpect Analysis can synchronise data with some Kromek devices, such as
RayMon. Connect the Kromek device to the PC running MultiSpect Analysis with a
USB cable.
The first time the device is connected drivers will be downloaded and installed from
the internet. If you do not have an internet connection on the PC running MultiSpect
Analysis, please download the following software and drivers from the Microsoft
website on another PC and install them on the PC running MultiSpect Analysis. When
the software drivers are successfully installed, the Kromek device will appear in
Windows Explorer.
•

Windows XP users: Microsoft ActiveSync 4.5 or later
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•

Windows 7, 8 and 101 users: Windows Mobile Device Centre 6.1 or later

After connecting the device, press ‘Import From Device’ at the top of the
‘Measurement Database’ window to display the ‘Device Import’ window, listing all
the measurements stored on the device.

Select the measurements to import by ticking the checkboxes next to the
measurements.
Pressing ‘Import Selected’ imports all the selected measurements.
The ‘Select’ menu at the top of the window allows different selections to be made:
•

Select all measurements on the device

•

Clear all the selections so none are selected

•

Select all new measurements not previously imported (shaded green)

•

Select measurements that have been modified on the device since they were
last imported (shaded blue)

•

Select all new and modified measurements

To delete the selected measurements from the device after they have been imported,
tick the checkbox ‘Delete from device after import’.
To delete measurements from the device without importing them, select the
measurements and click ‘Delete Selected’.

1

Some versions of Windows 10 have problems with importing from some Kromek
devices, including RayMon. If this affects you, please contact Kromek support (see the
back page of this manual)
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Finding measurements
The filters on the left of the ‘Measurement Database’ window allow searching for
particular spectra within the database. These allow searching by the:
•

Date on which the spectrum was recorded

•

Date on which the measurement was last edited

•

Name of the measurement

•

Detector serial number

•

Detector type

•

Device type used to capture the data from the detector, e.g. a PC

•

Serial number of the capture device

•

Contents of the notes associated with the spectrum

Completing any of the filters automatically filters out all the non-matching
measurements in the database. To return the filters to their default values press the
‘Reset’ button.

Exporting Data
Gamma ray spectra can be exported to .spe, .n42 or .txt files by selecting the
measurement and pressing the ‘Export’ button.
Neutron data can be exported to a .neutron file by selecting the measurement and
pressing the ‘Export’ button.

Settings
The ‘Settings’ ( ) button brings up the Measurement Library Settings menu, where
it is possible to configure the measurement database view. As well as modifying what
columns are visible, it is possible to change the time period over which results are
displayed by default. The latter should be made shorter if the database is slow to load.
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Backup
The complete database of measurements can be backed up to a single file from the
‘File’ menu by selecting ‘Database’, then ‘Backup DB’.

Restore
To restore a database, select ‘Restore Database’ from the ‘File’ → ‘Database’ menu
and choose which backup file to restore. All data in the existing database will be lost
when a previous database is restored. Administrator privileges are required for
restoring the database. If the user is not an administrator, they will be prompted to
enter the username and password of an administrator.

Reset
The database can be reset to a blank default database from the ‘Database Settings’
dialogue window. This is opened from ‘File’ → ‘Database’ → ‘DB Settings’ and the
reset option is found on the ‘Admin’ menu. Administrator privileges are required for
the reset. If the user is not an administrator, they will be prompted to enter the
username and password of an administrator.

36

Nuclide Database
MultiSpect includes a database of radionuclides. This can be accessed by clicking the
‘Nuclide Database’ button in the ‘Nuclides’ section of the ‘Analysis’ tab.
The Nuclide Database window
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Managing Nuclides
The Edit Nuclide Window

Creating custom nuclides
New nuclides can be added by clicking ‘Add Nuclide’. This brings up the ‘Edit Nuclide’
window, in which the properties of the new nuclide can be entered. On the right, it is
possible to select multiple categories, custom or default ANSI, to which the new
nuclide belongs. At the bottom of the window, energy lines of the nuclide can be
added, edited, or deleted as required.
Editing existing nuclides
Default radionuclides in the pre-installed database can also be viewed in more detail
by selecting them in the Nuclide Database window and clicking Edit Nuclide. This
brings up the ‘Edit Nuclide’ window, with the same options as for a custom nuclide.
However, the editing options of default sources are more limited. Categories for the
nuclide can be selected, and energy lines may be added, but pre-existing ones may
not be removed or edited. Fundamental properties such as the name, half-life, mass
etc. may also not be changed.
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Nuclide Categories
The Manage Nuclide Categories window

Managing Nuclide Categories
Clicking ‘Manage Categories’ in the ‘Nuclide Database’ window opens the ‘Manage
Nuclide Categories’ window. In this window, it is possible to add, edit and delete
custom categories. All categories can be viewed, but the default ANSI categories
cannot be edited or deleted.
When a custom category is created or edited, its Name and ANSI Category can be set.
The ANSI Category field is a text field that can contain any value, as the user desires.
Its intended function is to mark a corresponding or parent ANSI category of the newly
created category, but any text data may be stored there, or it may be left empty.

Spectrum Peak Analysis
MultiSpect Analysis has powerful features built in to automatically analyse peaks
from radiation source energy lines. Note: these features are not available in KSpect.
After selecting which radiation sources may be in the spectrum, MultiSpect Analysis
automatically analyses a suitable region of interest around each energy line and tells
you whether a significant peak exists at that energy.
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Note: Analysis is only available in energy display mode. The analysis features operate
on the active spectrum. The analysis updates automatically while data is being
acquired.

Enabling peak analysis
Peak Analysis is only available after moving to energy mode. Click the ‘Energy Mode’
button on the ‘Analysis’ toolbar.

Configuring peak analysis
Analysis is configured in the ‘Peak Analysis Nuclides’ and ‘Peak Analysis Options’
windows. In these windows you can:
1.
2.
3.
4.
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Select which radiation sources you expect may be present in the spectrum
Filter the energy lines of the radiation sources so only the important energy
lines are analysed
Change the analysis parameters
Look up radiation source energy lines by energy and relative intensity

The peak analysis nuclides window

Show/hide filtered peaks
Filter sources by name

Select radionuclides

Greyed-out lines are below
minimum relative intensity
Select energy lines
Energy
Relative intensity

Choosing radiation sources
MultiSpect Analysis has a library of all the common radiation sources and their
significant energy lines. The upper tree shows the radiation sources grouped by ANSI
category. The less common sources do not belong to an ANSI category, and are
grouped under the ‘(Uncategorised)’ heading. A few sources belong to more than one
ANSI category, and so appear more than once in the tree.
The ‘Search’ box makes it easy to find a radiation source. Enter the full nuclide name,
such as ‘Co-60’, or just the first few characters of the name. Clear the search box and
get back to the full tree by clicking on the

button.

Click on the checkbox beside the name of the radiation source to add it to the analysis.
Click on the checkbox again to remove the radiation source from the analysis.
Choosing energy lines
The lower tree shows the selected radiation sources, each with its energy lines. Each
energy line has a relative intensity. This shows the intensity of the energy line relative
to the other energy lines of the same radiation source, such that the sum of the
relative intensities of all the included energy lines of a radiation source is 100%.
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Note: some energy lines may not appear in the list. Energy lines outside a
configurable energy window, or below a specified minimum relative intensity, are
hidden when the filter button at the top of the window is enabled, and displayed in
grey when the filter is disabled. The energy window and minimum relative intensity
are set in the analysis configuration options window.
Peak analysis configuration options

Minimum intensity: Energy lines with a relative intensity less than this level can be
hidden using filter buttons on other windows.
Energy: Energy lines with an energy outside this range can be hidden using filter
buttons on other windows.
Upper and lower background window: The background under a peak in the spectrum
has to be removed before it can be analysed. The background is calculated by fitting
a straight line between the counts on either side of the ROI. These settings change
the energy range used in this calculation. Where data is not in 1-keV bins, the number
shown in brackets displays the actual energy range being used.
Second proportion of max: The analysis results table shows the full-width at halfmaximum (FWHM) for each detected peak, and another full-width at this proportion
of maximum. For example, if this value is set to 0.1, the second full-width is the fullwidth at one-tenth of maximum. The full-width ratio shown in the analysis results
table is this width divided by the full-width at half-maximum.
Peak ROI width factor: This value defines the percentage of peak events that are
covered by the region of interest based on the resolution function of the detector
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with respect to energy. For example, 95.45% uses a width equivalent to 2σ for a peak
at that position. A wider region of interest will give a more accurate result but will be
more susceptible to interference from radionuclides with peaks in a similar region of
the spectrum.
Critical limit: The analysis uses a critical limit test to determine whether a significant
peak exists at that energy. This value sets the required confidence level for the critical
limit calculation.
Confidence limits: The analysis calculates upper and lower confidence limits for the
net counts in a peak, and, if an efficiency calibration is present, the source activities.
This value sets the confidence level for the confidence limit calculations.
Minimum and maximum half-life: Only energy lines from radiation sources that fall
within this half-life window are analysed. If set to 0, no limit is applied.

Peak area and FWHM analysis results
The ‘Peak Analysis Table’ is displayed when the ‘Results’ menu button is clicked. View
the ‘Peak Area’ tab to see the measurements of peak areas and full widths at half
maxima (FWHM).

The analysis results are colour coded for ease of interpretation as follows:
•

Green: The spectrum has a peak in the same energy region above the level
of statistical confidence specified in the analysis configuration options; the
critical limit test has been passed.
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•

Blue: The spectrum fails the critical limit test in this region.

•

Red: Lines that have been excluded from analysis because they fall outside
the conditions specified in the analysis configuration options.

The shading within each colour indicates the relative intensity of the line. For
example, dark blue indicates a line with a high relative intensity where the critical
limit test has been failed.
The table shows a list of all the energy lines included in the analysis. Each column
heading can be clicked to sort the data by that column.
•

Source: The radioactive source of the energy line.

•

Energy: The energy of the energy line in keV.

•

Relative Intensity: The intensity of emission of the energy line, as a
percentage of all of the emissions of the source.

•

Half-life: The half-life of the source. Units vary, and are displayed in the
column.

•

Centroid: The centroid of the region in keV. If a background line could be
determined, this is the centroid of the net count, else of the gross count.

•

Gross count: The total of all counts in the region of interest.

•

Net count: The gross counts less the counts below the ‘background line’ –
the straight line connecting the average counts in the left-hand background
window of the region of interest with the average counts in the right-hand
background window.

•

Upper and lower confidence: The confidence limits for the net count in the
peak, to the configured confidence level (see above). This defines the range
containing the true (rather than measured) number of events due to the
energy line, to the configured level of confidence.

•

FWHM: Full-width at half-maximum, in keV. The width of the peak (net
counts only) at half the maximum net counts in the peak.

•

FWnM: Full-width at n of maximum, in keV. The width of the peak (net
counts only) at the configured "second full width proportion of maximum"
of the maximum net counts in the peak.

•

FW ratio: The ratio of FWnM to FWHM.

The buttons on the top bar perform the following operations:
Filter energy lines above the critical limit and associated nuclide lines:
When enabled, the analysis table only shows radionuclides where at
least one line has passed the critical limit test.
Filter relative intensity: When enabled, emission lines that fall below
the specified minimum intensity are hidden from the analysis results
table.
Filter energy range: When enabled, emission lines that fall outside the
specified energy window are hidden from the results table.
Filter half-life: When enabled, emission lines from radionuclides with
half lives outside the specified range are hidden from the results table.
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Analysis results can be exported by selecting ‘Export…’ from the top of the Peak
Analysis Table. The exported data contains additional columns, such as the critical
limit used to test for the presence of a peak.

Activity from peak areas
Note: This functionality is only present in MultiSpect Analysis Premium
After determining the efficiency calibration curve of the system (see the calibration
section on page 18), the activity of a source can be measured from the net counts in
its spectrum peaks. The sample must be positioned in the geometry matching the
efficiency curve, and the Peak ROI width factor for the analysis must be the same.
Simply acquire a spectrum from the source in the geometry of the efficiency curve
and perform a Spectrum Peak Analysis (see page 39) to measure the photo-peaks in
the spectrum. On the ‘Peak Analysis Table’, click the ‘Peak Activity’ tab to view the
results of the analysis in terms of activity using the efficiency curve loaded in
‘Detector Settings’. Only peaks that have passed the critical limit test where a net
count rate has been measured are analysed for activity. The units of measurement
can be changed between SI and US Standard from the ‘Preferences’ screen accessed
from the main ‘File’ menu.
The efficiency curve can be viewed by pressing ‘View Efficiency Calibration…’ above
the results table, and a new calibration loaded if necessary. If no efficiency curve is
present, no results will be displayed.

Each emission line analysed gives a separate measure of the activity of the sample.
The upper and lower confidence values are calculated using the error from the fit to
the efficiency calibration points, the error in the net counts measured from the
spectrum, and the ‘confidence limits’ chosen by the user in ‘Peak Analysis Options’,
e.g. 1σ/68%.
Activity results can be included in .pdf reports (see page 27). They can also be
exported to a .csv file by using the ‘Export…’ button above the results table. When
the measurement is saved in the database the complete configuration is saved with
the measurement allowing the same analysis to be recalled at a later date.
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Graphical display of analysis

When analysis is enabled, the graphical display shows the regions of interest of the
peaks being analysed. Each energy line in the analysis is shown with:
•

A vertical dotted line at the energy of the energy line. This line is strongly
dashed if a peak was detected. Otherwise it is lightly dotted.

•

Text beside the peak, with the nuclide name, energy line energy and
user-entered comment.

•

Vertical dashed lines at the right and left boundaries of the region of interest.

•

Shading of the region of interest under the spectrum trace.

•

Darker shading below the background level in the region of interest.

All the energy lines of a radiation source are shown in one colour. The energy lines of
different radiation sources are shown in different colours.
If a peak was detected in the region of interest, the graphical display of the energy
line is shown brightly. Otherwise it is shown dimly, unless you hover the mouse over
an element of the energy line (the centre energy line, a region of interest bounds line,
or the text).
The filter buttons in the ‘Peak Analysis’ section of the ‘Analysis’ tab can be used to
control what analysis information is displayed on the graph.
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Show ROI: pressing this shows/hides the dashed lines marking the limits
of the region of interest for each radionuclide line from the graph.
Show Text: pressing this shows/hides text labels on the graph. They are
still displayed when the mouse is hovered over the peak centre
markers.

User-entered comments
Comments can be added or edited by right-clicking on the energy line in the graphical
spectrum display and choosing ‘Edit text’ in the menu.

Saving and loading the analysis configuration
The analysis configuration will be saved with the spectrum in the database and
recalled the next time the measurement is opened.
If the analysis configuration will be used frequently it can be added to the list of
favourite configurations allowing it to be quickly applied to any spectrum.

•

Save favourite configuration: After setting up the analysis, click on
’Save as Favourite...’ in the ‘Favourites’ menu and name the configuration to
add it to the list of favourites.

•

Apply favourite configuration: An existing favourite can be applied to a
spectrum by selecting it from the drop-down ‘Favourites’ list.

•

Organise Favourites: Favourite configurations can be managed by selecting
"Organise Favourites...".
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•

Choose default favourite configuration: After selecting a favourite select
‘Set Default’ to make this the default configuration for future
measurements.

•

Rename favourite configuration: The name of the favourite can be changed
by selecting it and pressing ‘Rename’.

•

Delete favourite configuration: To remove a favourite configuration select
it and click the ‘Remove’ button.

•

Export/Import favourite configuration: A favourite configuration can be
exported to a .msa file so it can be saved and transferred to other MultiSpect
Analysis installations. To export select the configuration and click the
‘Export’ button. To import a .msa file click ‘Import’ and navigate to the file.

Simplified Activity Analysis in MultiSpect
Note: Quant for GR1 users need to apply an enhanced MultiSpect Analysis Premium
software licence to enable these activity features.
Activity analysis quantifies the radioactivity of a sample from its gamma ray spectrum
which must be recorded in a pre-defined geometry using the Quant for GR1
accessories. The efficiency values used for the analysis are provided in the software,
removing the need for the user to characterise the system. If required, the efficiency
values can be updated by the user after calibration.
After selecting which radiation sources may be present and the geometry of the
measurement, MultiSpect Analysis calculates the quantity of each radionuclide. The
analysis features operate on the selected spectrum and the analysis updates
automatically while data is being acquired. Activity analysis is only available in energy
display mode.
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Disclaimer: When using the provided efficiency values, the activity results will be
compromised if the sample or geometry deviates from the ideal case. The user is
responsible for qualifying the system and ensuring the results are appropriate for
their needs.

Starting activity analysis

After, or while, acquiring a spectrum, switch to Energy Mode by clicking the
‘Energy Mode’ button on the ‘Spectra’ or ‘Analysis’ tabs.

Configuring activity analysis
Activity analysis is configured from the ‘Activity Analysis Nuclides’ and
‘Activity Analysis Options’ windows. These can be opened using the buttons in the
‘Activity Analysis’ section of the ‘Analysis’ tab. The units of measurement can be
changed between SI and US Standard from the ‘Preferences’ screen which can be
accessed from the main ‘File’ menu.
Choosing radiation sources
MultiSpect Analysis will analyse the sample for common radiation sources. The
‘Activity Analysis Nuclides’ tree shows the radiation sources grouped by ANSI
category that are available for analysis. Click on the checkbox beside the name of the
radiation source to add it to the analysis. Click on the checkbox again to remove the
radiation source from the analysis. The ‘Search’ box makes it easy to find a radiation
source. Enter the full nuclide name, such as ‘Co-60’, or just the first few characters of
the name. Clear the search box and get back to the full tree by clicking on the
button.
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Analysis configuration options

These parameters configure the analysis:
•
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Upper and lower background windows: The background under a peak in the
spectrum has to be removed before activity can be calculated. The
background is calculated by fitting a straight line between the counts on
either side of the ROI. These settings change the energy range used in this

calculation. Where data is not in 1-keV bins, the number shown in brackets
displays the actual energy range being used.
•

Peak ROI width factor: This value defines the percentage of peak events that
are covered by the region of interest based on the resolution function of the
detector with respect to energy. For example, 95.45% uses a width
equivalent to 2σ for a peak at that position. A wider region of interest will
give a more accurate result but will be more susceptible to interference from
radionuclides with peaks in a similar region of the spectrum.

•

Confidence level for critical limit: The analysis uses a critical limit test to
determine whether a significant peak exists at that energy. This value sets
the required confidence level for the critical limit calculation.

•

Confidence level for quoted uncertainty: The analysis calculates the
uncertainty in the calculated activity. This value sets the confidence level
used in calculating the uncertainty.

•

Sample type: The type of sample being analysed affects the geometry of the
measurement and needs to be taken into account in the calculation of the
activity. Select one of the options for the type of sample being measured:
o Maypack (Charcoal) for standard Maypack charcoal filters.
o Filter for filter papers.
o Maypack (Charcoal) and Filter for a combined measurement of
Maypack charcoal and filter paper.
o Beaker is for a standardised beaker filled with material. If this
option is selected additional parameters are required for the
volume and weight. The material is assumed to be uniformly
distributed in the beaker, with a density matching water, and with
negligible self-absorption of radiation.
o Calibration Source is for use with the standard calibration source.
Calibration source = QCRB19952 NG3 mix from HTSL (High
Technology Sources Ltd).
o RayMon Filter for analysis of data imported from a RayMon
handheld detector using the RayMon Quant accessories.
o RayMon Beaker for analysis of data imported from a RayMon
handheld detector using the RayMon Quant accessories.

Results
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The ‘Activity Analysis Table’ shows the results of the activity analysis. The column
headings can be clicked to sort the data. The ‘Export’ button allows the results to be
saved in .csv format.
Columns show:
•

Source: The radionuclide that has been analysed.

•

Result: The calculated activity of the radionuclide.

•

Uncertainty: The uncertainty in the calculated activity.

•

MDA: The minimum detectable activity for the radionuclide in the
measurement. This provides an upper limit on the activity where it has not
been possible to quantify the radionuclide.

Saving and loading the analysis configuration
The analysis configuration will be saved with the spectrum in the database and
recalled the next time the measurement is opened.
If the analysis configuration will be used frequently it can be added to the list of
favourite configurations allowing it to be quickly applied to any spectrum.
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•

Save a favourite configuration: After setting up the analysis click on ‘Save as
Favourite’ in the favourites menu above the radionuclide selection tree and
name the configuration to add it to the list of favourites.

•

Apply favourite configuration: An existing favourite can be applied to a
spectrum by selecting it from the top of the drop down list above the
radionuclide tree.

•

Organise Favourites: Favourite configurations can be managed by selecting
‘Organise Favourites’.

•

Choose default favourite configuration: After selecting a favourite select
‘Default’ to make this the default configuration for future measurements.

•

Rename favourite configuration: The name of the favourite can be changed
by selecting it and pressing ‘Rename’.

•

Delete favourite configuration: To remove a favourite configuration select
it and click the ‘Delete’ button.

Calibration of simplified activity
Specific efficiency values, ke, used in this simplified activity analysis for each
radionuclide can be updated from user acquired absolute efficiency curves. These
must already have been recorded with a ‘Peak ROI Width Factor’ of 95.45%. Please
see page 18 for creating this calibration curve.
From the ‘Setup menu’ select ‘Radionuclide Efficiency Values’.

This will open a window allowing the values used in the efficiency analysis to be
updated. First select the geometry and then select the efficiency curve to use for
calculating the new values. Calculated ke values, which are the efficiency values
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adjusted for the probability of emission of the radionuclide emission line, are
displayed in the table. To accept these new values, press the ‘Apply’ button.

To revert back to the pre-determined values from Kromek select the ‘Kromek Default
Values’ in the efficiency drop down box. Changes to these ke values will affect all
measurements, including historic measurements in the database. Note that in this
simplified activity calculation the errors on the fit to the efficiency curve are not taken
into account in calculating the errors on the final activity.

Scripting
KSpect and MultiSpect Analysis provide the ability to automate various operations
through a scripting system. This scripting capability is accessed by selecting ‘Script
Window’ under the ‘File’ menu. From this window, scripts can be loaded, edited,
saved, compiled, and executed. The scripts must be written in the C# language
(Microsoft Visual C# 2005) and must follow the form given in the examples below.
Control of the software is provided through the properties and methods described in
the Scripting Manual. Please refer to this manual for the full list of properties and
methods. To access this document, open the scripting window and click
‘Help’ → ‘Scripting Manual’.
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Example: repeat measurements with a single detector
namespace USBSpect{
public class Script : ScriptInterfaces.IScriptScript
{
ScriptInterfaces.IScriptHost pspect;
public void InitializeScript(ScriptInterfaces.IScriptHost hostObject)
{
pspect=hostObject;
}
public void PSpectScript()
{
// Number of times to repeat acquisition
const int totalPasses = 10;
// Choose a file name stem which will be appended by the repeat number
const string saveFileStem = "Measurement";
//Set measurement live time in seconds
pspect.setLiveTime(30);
for (int p = 0; p < totalPasses; ++p)
{
pspect.eraseActiveSpectrum();
pspect.startAcquisition();
pspect.waitForAcquisitionStop();
string fileName = string.Format("{0}_{1}", saveFileStem, p + 1);
pspect.saveActiveSpectrum(fileName);
}
}
}
}
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Example: repeat measurements with multiple detectors

namespace USBSpect{
public class Script : ScriptInterfaces.IScriptScript
{
ScriptInterfaces.IScriptHost pspect;
public void InitializeScript(ScriptInterfaces.IScriptHost hostObject)
{
pspect=hostObject;
}
public void PSpectScript()
{
// The serial numbers of each of the detectors
string[] detectorSerialNumbers = new string[] {"Serial 1", "Serial 2"};
// Number of times to repeat acquisition
const int totalPasses = 5;
// Choose a file name stem which will be appended by the repeat number
const string saveFileStem = "Measurement";
// Set measurement live time in seconds
pspect.setLiveTime(60);
for (int p = 0; p < totalPasses; ++p)
{
foreach (string det in detectorSerialNumbers)
{
pspect.setActiveSpectrum(det);
pspect.eraseActiveSpectrum();
}
pspect.startAcquisition();
pspect.waitForAcquisitionStop();
foreach (string det in detectorSerialNumbers)
{
pspect.setActiveSpectrum(det);
string fileName = string.Format("{0}_{1}", saveFileStem, p + 1);
pspect.saveActiveSpectrum(fileName);
}
}
}
}
}
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Execution at start up
A script can be run automatically when the software is started by adding the script
file specification as a command line argument when executing the application. For
example, the following will run KSpect/MultiSpect and then load and run the script
ExampleKSpectScript.cs located in the root directory of the C: drive.
1.
2.
3.

Select Run from the Start menu.
At the Open: prompt enter (include the quotation marks): “C:\Program
Files\Kromek\MultiSpect\MultiSpect.exe” “C:\ExampleKSpectScript.cs”
Click the OK button to run the command.
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